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About FabFilter Pro-C 3
There is one signal-processing tool that is almost impossible to do without in any form of audio recording or post-
production: compression. Compression is available in a wide variety of different formats, flavors, designs and degrees of
quirkiness.

FabFilter Pro-C 3 is not just a good sounding compressor: it is a superb stereo and surround compressor with all the
tricks up its sleeve that you will ever need. With its different compression styles, analog character modes and options
like mid/side compression and side-chaining with optional EQ filtering, it can work in any desired way. Whether
mastering or mixing, Pro-C 3 will do the job with lots of style.

New in version 3

When you open Pro-C 3 for the first time, the layout is familiar, but you will immediately notice that it has a brand new,
modern look. With its gorgeous, resizable interface, optional level display, knee display and side-chain controls, it can
either take the form of a classic, straightforward analog compressor, or present itself as a modern all-round compressor
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with extensive metering and controls. It's up to you!

Of course, apart from the new look and feel, we've also added great new features. Most importantly, FabFilter Pro-C 3
introduces six brand-new compression styles. It's like getting six new compressors!

Versatile - As the name implies, works great on any material. It's punchy at longer attack times but tight and
smooth at shorter times

Smooth - Designed to stay smooth at all times, especially suitable for glueing with low ratio and longer times

Upward - Pumping, upward compression, like Saturn's much praised Dynamics knob, but with more control over
its behavior

TTM - To The Max multiband mayhem, using combined downward and upward compression

Op-El - Effortless opto-like tube compression, smooth and warm

Vari-Mu - A classic variable mu topology, offering smooth and colorful feedback compression

But of course, we didn't stop there:

Introducing Character modes: built-in, carefully designed analog saturation, coloring and drift brings Pro-C 3 to
life. With customizable Drive and Pre/Post-compression routing settings

Highly improved side-chain EQ section. You can now freely add up to six bands, and use all shapes you already
know from Pro-Q 4, including all-pass and brickwall filters. You can even set bands to mid- or side-only

Introducing host tempo triggering, with customizable sync, offset and pulse length settings

Full immersive / Dolby Atmos® functionality (up to 9.1.6), with customizable channel/stereo linking

Introducing Auto Threshold: it makes the threshold level work input level-independent

Pro-C 3 instances can now be controlled via the Instance List in Pro-Q 4 (starting with Pro-Q 4.10), together with
Pro-G and Pro-DS instances

Introducing the option to set a maximum lookahead between 1 and 20 ms to finetune the latency versus the
needed lookahead

Up to 32x oversampling

Overall new and fresh design

New-style preset browser, with easy search, tags and meta data

MIDI triggering is now more easily accessible via the trigger input selector in the side chain section

Improved reverse-linking of Dry and Wet level knobs (using Alt+drag, or Shift+drag in Pro Tools)

Many minor improvements

Upgrading to Pro-C 3

Upgrading from Pro-C version 2 to the new Pro-C 3 is safe and easy: installing Pro-C 3 will not replace or delete the
previous Pro-C 2 plug-in. Both versions will co-exist and can both be used at the same time. This ensures that you can
open old songs that use Pro-C 2 without problems! FabFilter Pro-C 3 opens presets from Pro-C 2 without problems. See
Upgrading to Pro-C 3 for more information.

FabFilter Pro-C 3 is available in VST, VST3, CLAP, AU (Audio Units), AAX Native and AudioSuite formats.

Windows requirements

Windows 11, 10, 8, 7 or Vista

64-bit or 32-bit

VST 2/3 or CLAP host, or Pro Tools

macOS requirements

macOS 10.13 or higher (64-bit only)

VST 2/3, AU or CLAP host, or Pro Tools

Intel or Apple Silicon processor

Next: Quick start

See Also
Using FabFilter Pro-C 3

4

file:///Users/florisklinkert/Documents/FabFilter/Projects/Pro-C/Help/Html/using/styleandcharacter.html
file:///Users/florisklinkert/Documents/FabFilter/Projects/Pro-C/Help/Html/using/styleandcharacter.html
file:///Users/florisklinkert/Documents/FabFilter/Projects/Pro-C/Help/Html/using/sidechainsection.html
file:///Users/florisklinkert/Documents/FabFilter/Projects/Pro-C/Help/Html/using/sidechainsection.html
file:///Users/florisklinkert/Documents/FabFilter/Projects/Pro-C/Help/Html/using/surround.html
file:///Users/florisklinkert/Documents/FabFilter/Projects/Pro-C/Help/Html/using/dynamicscontrols.html
file:///Users/florisklinkert/Documents/FabFilter/Projects/Pro-C/Help/Html/using/instancelist.html
file:///Users/florisklinkert/Documents/FabFilter/Projects/Pro-C/Help/Html/using/timecontrols.html
file:///Users/florisklinkert/Documents/FabFilter/Projects/Pro-C/Help/Html/using/oversampling.html
file:///Users/florisklinkert/Documents/FabFilter/Projects/Pro-C/Help/Html/presets/loadingpresets.html
file:///Users/florisklinkert/Documents/FabFilter/Projects/Pro-C/Help/Html/using/sidechainsection.html
file:///Users/florisklinkert/Documents/FabFilter/Projects/Pro-C/Help/Html/support/upgrading.html
file:///Users/florisklinkert/Documents/FabFilter/Projects/Pro-C/Help/Html/intro/quickstart.html
file:///Users/florisklinkert/Documents/FabFilter/Projects/Pro-C/Help/Html/using/overview.html


Quick start
The installer will copy the FabFilter Pro-C 3 plug-in into the common VST, VST 3, CLAP, AU (macOS only) and Pro Tools
plug-in folders on your computer. On macOS, the global plug-in folders in /Library/Audio/Plug-Ins are used.

In most cases, your host will then recognize the plugin automatically. However, if the instructions below do not work,
see Manual installation instead.

Pro Tools
Choose an empty insert slot on one of your audio tracks, instrument tracks or buses and select FabFilter Pro-C 3
from the pop-up menu in the Dynamics section.

Studio One
Click the '+' button next to the Inserts tab of an audio track, instrument track or bus and select 'Pro-C 3' from
the drop-down menu.

Logic Pro
Choose an empty insert slot on one of your audio tracks, instrument tracks or buses and select FabFilter Pro-C 3
from the pop-up menu. You will find FabFilter Pro-C 3 in the Audio Units > FabFilter section (named Pro-C 3).

Ableton Live
In Session view, select the track you would like to place FabFilter Pro-C 3 on, for example by clicking the track
name. At the left top of Ableton Live's interface, click on the Plug-in Device Browser icon (third icon from the
top). From the plug-ins list, double-click FabFilter > Pro-C 3, or drag it onto the track.

Cubase
Choose an empty insert slot, for example in the Mixer, and select Dynamics > Pro-C 3 from the menu that
appears. To use the MIDI features in Pro-C 3, create a new MIDI track and set its output to the Pro-C 3 instance
you have just created.

To begin, choose fast attack and release times, put the ratio to a gentle setting (like 4:1) and bring down the
threshold to make compression audible. Adjust the parameters until you have the desired effect. Have fun!

Next: Using FabFilter Pro-C 3

See Also
Manual installation
VST plug-in versions
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Overview
The interface of FabFilter Pro-C 3 is designed to be easy to use while providing all necessary information and controls. It consists
of the following elements:

Level display
The animated level display shows you the incoming and processed audio signals together with the gain reduction. It helps
you detemine the correct compressor settings. If desired, you can hide the level display by switching to Compact layout
using the Resize button. This also hides the knee display and changes the vertical level meters to horizontal ones, making
Pro-C 3 look and feel more like a traditional compressor. See Displays and metering.

Knee display
The Knee display visualizes the input/output transform of the detection circuit, including the effect of the Threshold, Ratio,
Knee and Range parameters. It conveniently uses the same scale as the level display underneath. Use the Knee button to
show or hide the knee display. See Displays and metering.

Dynamics, style, character and time controls
At the heart of the interface you will find the main compressor controls. Threshold, Ratio, Knee and Range control the
triggering and how much compression is applied. Style and Character control the flavor and color of the sound. The Attack,
Release, Lookahead and Hold affect the smoothing and curves of the gain reduction. See Dynamics controls, Style and
character and Time controls.

Level metering
At the right-hand side of the interface, the gain reduction and output level meters provide an immediate overview of the
current levels. Optionally an input meter can also be shown. The input and output level meters show both peak and
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loudness levels. See Displays and metering.

Side chain controls
The Side Chain button at the center bottom of the main control section shows or hides the advanced side chain controls. In
this panel, you can customize the side chain input, level, stereo/channel linking, and EQ'ing. See Side chain section.

MIDI Learn
MIDI Learn lets you easily associate any MIDI controller with any plug-in parameter. See MIDI Learn.

Oversampling
The Oversampling setting sets the amount of internal oversampling, which reduces possible aliasing for fast/aggressive
dynamics processing, at the cost of additional CPU usage. See Oversampling.

Input and output options
At the right of the bottom bar, you can bypass the entire plug-in and adjust the initial input and final output levels. See
Input and output options.

Full Screen mode, resizing and scaling
The Resize button at the far right of the bottom bar lets you change the interface size and scaling. In addition, click the Full
Screen button in the top-right corner of the interface to let Pro-C fill the entire screen. See Full Screen mode, resizing and
scaling.

Presets, undo, A/B, help
With the preset buttons, you can easily browse through the factory presets or save your own settings so you can re-use
them in other songs. The Undo, Redo, A/B and Copy buttons at the top of the plug-in interface enable you to undo your
changes and switch between different states of the plug-in. Finally, the Help menu provides access to help and version
information. See Loading presets and Undo, redo, A/B switch.

To learn more about compression in general, we highly recommend visiting the Compression section  in our online FabFilter
Learn tutorials.

Next: Knobs

See Also
Quick start
Dynamics controls
Time controls
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Knobs
It is easy to control FabFilter Pro-C 3's parameters with the large round knobs. They will light up when you move the
mouse cursor around to indicate that you can adjust them. The moment you move the mouse cursor over a knob, a
parameter value display will pop up, which shows the name and the current value of the parameter.

All knobs support three ways of control:

1. Vertical mode
Click on a knob and drag up or down to rotate it. The knob reacts to the speed with which you are dragging,
so if you move the mouse slowly, you make precise adjustments.

2. Mouse wheel mode
Perhaps the easiest way to make adjustments is by using the mouse wheel when you hover over a knob. This
mode works for all the knobs and possible panning rings. (On Windows, you might need to click in the plug-in
interface first to make sure it is the active window.)

3. Text entry mode
Double-click a knob to enter an exact value using the keyboard.

Tips

To reset a knob to its default position, hold down the Ctrl key (Windows) or Command key (macOS) and click
the knob once. Note: In Pro Tools, Pro-C 3 uses the default Pro Tools keyboard shortcut for reset: Alt+click.

To fine-tune a value when using vertical drag mode or the mouse wheel, hold down the Shift key while
dragging or moving the mouse wheel. Note: In Pro Tools, Pro-C 3 uses the default Pro Tools keyboard shortcut
for fine tune: Ctrl+drag on Windows or Command+drag on macOS.

There are several handy shortcuts in text entry mode. With frequency values, you can type e.g. '1k' to set
the value to 1000 Hz, and also 'A4' for 440 Hz, or even strings like 'C#3+13'. With dB values, you can type e.g.
'2x' to get +6 dB (the value that corresponds to two times louder). With all values, you can also type a
percentage (e.g. '50%' will put a knob exactly in the middle position).

Sometimes, knobs in our plug-in interfaces are linked: these can be adjusted simultaneously by holding down
the Alt key (Shift key in Pro Tools) while dragging on one of them. For example, an output level and input level
setting of a plug-in could be adjusted simultaneously (in the opposite direction) this way.

Next: Dynamics controls

See Also
Using on iOS
Using FabFilter Pro-C 3
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Dynamics controls
The left part of the main compressor settings contains the controls that affect the detection path of the compressor.

The Threshold knob determines above which side chain level the gain should be reduced. The circular side-
chain level meter around the Threshold knob shows the level of the filtered and possibly stereo-linked signal that
is used for detection. This feedback makes it a lot easier to choose a proper Threshold setting.

The Auto Threshold button (the AUTO label next to THRESHOLD) toggles auto mode on or off. When enabled,
the theshold will work level-independent. So, triggering on a certain signal at different input levels, will result in
the same amount of compression. This can be very useful in case of dialog processing, for example, where some
parts are often louder than others, while still requiring the same kind of dynamic processing.

As soon as you enable Auto Threshold, a Lock Auto Threshold button will appear. If active, the current Auto
Threshold setting is preserved while skipping presets.

With the Audition Triggering button, at the left top of the Threshold button, you can hear on which parts of
the audio Pro-C 3 is triggering and how much compression is taking place. This helps you choose an appropriate
Threshold level as well, making sure Pro-C catches the necessary peaks.

The Ratio knob sets the amount of compression. At a ratio of 10:1, just one dB of output signal above the
threshold remains for every 10 dB of input signal above the threshold. If you move the knob completely to the
left (1:1), no compression will take place. If you move it completely to the right (infinity), everything above the
threshold will be completely compressed away, letting Pro-C act as a limiter.

The Knee slider below the Threshold knob sets the 'roundness' of the compression around the threshold, which
can vary from 0 dB (hard knee) to 72 dB (soft knee). Using a soft knee can help to make the compression more
gradual and transparent. With very soft knee settings (> 60 dB), in combination with a fast Attack setting, you
can achieve almost saturation-like effects.

The Range slider below the Ratio knob limits the maximum amount of applied gain change that can be
achieved. Compare this to the Ratio slider which scales the dynamics behavior instead.

Tips

To learn more, read the Basic compressor controls  article in our online FabFilter Learn tutorials.

Instead of using the incoming audio to trigger the compressor, you can also trigger it using the external side
chain, a pulse synched to host tempo or MIDI. See Side chain section.

The Threshold knob is reverse-linked with the Character Drive slider. This makes it easy to 'trade' compression
for saturation in one movement.

Due to the nature of the Vari-Mu algorithm, changing the side chain level slider (i.e driving the compressor less
or more), has a very different effect than adjusting the threshold. Do experiment with it, as it really does open
up a whole world of different flavors.

Next: Time controls

See Also
Side chain section
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Using FabFilter Pro-C 3
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Time controls
The right part of the main compressor settings contains the controls that affect the smoothing and curve shape of the
gain change signal, and the wet/dry mixing controls.

The Attack knob determines how fast compression will kick in, ranging from 0.005 ms (very fast) to 250 ms
(very slow). For transient-rich program material like drums, fast attack times are needed to minimize overshoot.
For other program material, too short attack times may dull the sound or introduce audible distortion. FabFilter
Pro-C is capable of very fast attack times and they are program-dependent.

The Release knob sets the time that the compressor takes to recover from gain reduction. The various
compression styles in Pro-C 3 use different release models, and in most cases, the release time is very program-
dependent. This means that Pro-C 3 recovers very quickly from compression after a transient, and quite slowly
after longer periods of gain reduction. Note: When Auto Release is used, the Release knob will adjust the overall
effect of the auto release feature on the release time.

The Auto Release button (the AUTO label next to RELEASE) enables a smart auto release feature. When
enabled, the compressor adjusts the release time depending on the current amount of gain reduction, so this
actually introduces an additional form of program-dependency. When Auto Release is used, the Release knob will
adjust the overall effect of the auto release feature on the release time.

The Lookahead slider sets how much advance time Pro-C 3 will use to anticipate peaks in the audio signal.
Using a bit of lookahead can help to preserve transients and results in much more transparent gain reduction.
Because lookahead causes additional latency, you can globally enable or disable it in the bottom bar with the
Maximum Lookahead button. Click it to choose between Off and various settings, up to a maximum of 20 ms.
This allows you to use lookahead while minimizing the combined latency of your processing chain.

The Hold slider sets the time with which peaks in gain reduction will be prolonged. Applying a bit of hold time
can help increase the transparency of gain reduction. With longer hold times, you can achieve nice pumping
effects.

The Wet Gain knob adjusts the gain of the signal after it has been compressed. This is also known as make-up
gain because it compensates for the gain reduction introduced by the compressor. The pan ring around the Wet
Gain knob controls the balance between mid and side. This can be especially useful when applying make-up gain
after mid-only or side-only compression.

When Auto Gain is enabled (using the AUTO button next to GAIN), automatic make-up gain is applied to the
processed signal, depending on current settings for Threshold, Ratio, Knee and Attack. Auto Gain helps you to
keep the audible audio level the same while adjusting the controls. The Auto Gain algorithm is aware of mid-only
or side-only processing. So for example, if you're compressing 100% mid-only, Auto Gain will only apply make-
up gain to the mid signal and leave the side-signal untouched.

Note that the auto-gain algorithm doesn't actually measure loudness to determine which gain to apply. It just
makes an educated guess, so you might want still to tweak the output gain in some situations.

The Dry Gain knob controls the amount of dry (uncompressed) input signal that is added to the output. This is
called parallel compression: the dynamics in the dry signal are preserved while the compressed signal adds body
and character to the overall sound. The advantage of this is that the sound is reinforced where it needs it, but
without the risk of crushing any peak transients.
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Program-dependency

The different compressor styles in FabFilter Pro-C 3 all have their own kind of program-dependency. This means that
the compressor reacts differently to different kinds of input (program material). For example, Pro-C 3 will recover very
fast from transients (fast changes/peaks), but will react quite a bit slower after longer periods of gain reduction. Both
the attack and release times are less or more program-dependent, depending on the chosen compression style.

Tips

To learn more, read the Basic compressor controls  article in our online FabFilter Learn tutorials.

The Wet Gain and Dry Gain knobs are reverse-linked. If hold down the Alt key (Shift key in Pro Tools) while
dragging down the Wet Gain, the Dry gain will be brought up with the same amount.

Next: Style and character

See Also
Dynamics controls
Using FabFilter Pro-C 3
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Style and character
Most compressors have the same set of classic controls, like Threshold, Ratio, Attack and Release. Yet they can sound
very different, even when trying to match settings. This is because internally, all compressors work differently, using
different detection algorithms, different topologies and different smoothing curves. And especially in analog/hardware
compressors, there can be more factors that contribute to the sound, like transformers or tubes.

With Pro-C 3's Style and Character options, you can combine a variety of compressor styles with different types of
analog coloring. So you don't just get one compressor, you get many!

The Style button selects the style or compression. Pro-C 3 offers 14 different styles, all with their own characteristics,
divided into three categories.

Modern:

Clean - An allround, low distortion, feedforward, program dependent style

Versatile - As the name implies, works great on any material. It's punchy at longer attack times but tight and
smooth at shorter times (new in Pro-C 3)

Smooth - Designed to stay smooth at all times, especially suitable for gluing with low ratio and longer times
(new in Pro-C 3)

Punch - Traditional, analog-like compression behavior, sounds good on anything!

Upward - Pumping, upward compression (increasing the level when it drops below the threshold), like Saturn's
much praised Dynamics knob, but with more control over its behavior (new in Pro-C 3)

TTM - To The Max multiband mayhem. The TTM style combines upwards and downwards compression on
multiple bands, making the input signal louder when it's quiet and quieter when it's loud. In this style the
threshold effectively becomes a target level. The knee then controls the blending between the two stages,
allowing you to further shape the pumping behavior (new in Pro-C 3)

Classic:

Op-El - Effortless opto-like tube compression, smooth and warm (new in Pro-C 3)

Vari-Mu - A classic variable mu topology, offering smooth and colorful feedback compression (new in Pro-C 3)

Classic - A vintage, feedback, very program dependent style

Opto - A relatively slow, very soft knee, more linear opto style

Utility:

Vocal - A very effective algorithm to bring vocals to the front of your mix. It works with automatic knee and
13



ratio settings, so compressing your lead vocal is as easy as choosing the right threshold

Mastering - Designed to be as transparent as possible, introducing as little harmonic distortion as possible,
while still being able to catch those fast transients

Bus - Especially great for bus processing, or for adding a pleasant glue to your drums, mixes or tracks

Pumping - Deep and over-the-top pumping, great for drum processing or EDM

The Character button right below the Style button opens the Character panel with the following settings:

Character mode sets the type of analog saturation, color and drift. You can choose between Off (disabled),
Tube, Diode and Bright. All three options have their own character and introduce different harmonics and
coloring. Try them!

Drive sets the level at which the saturation circuit is driven internally which affects the amount of saturation and
harmonics.

Routing determines whether saturation takes place before (Pre) or after compression is applied (Post). By
default, it's set to Post, which will nicely saturate transients that remain when applying compression with higher
attack values. When set to Pre, the signal and peaks in the input will be saturated before compression, which
results in a wholly different character.

Tips

You can also use the mouse wheel when hovering above the Character button to toggle between the different
character modes.

The Character Drive slider is reverse-linked with the Threshold knob. This makes it easy to 'trade' compression
for saturation in one movement.

Next: Side chain section

See Also
Dynamics controls
Using FabFilter Pro-C 3

14

file:///Users/florisklinkert/Documents/FabFilter/Projects/Pro-C/Help/Html/using/sidechainsection.html


Side chain section
Click the Side Chain button (centered under the main compressor controls) to show or hide the advanced side chain
controls.

If any of these advanced features has a non-default setting that affects the sound of the compressor, the button will
clearly indicate this with a yellow glow and text. In addition, if you've chosen a non-default trigger input, the
appropriate icon will be shown next to the button indicating this. So when you're skipping presets, you can easily see
that advanced side chain features are in effect.

The Side Chain Level slider at the left adjusts the level of the incoming trigger signal. This can for example be
useful if the input level is quite soft. Setting a proper input level is easy using the circular side chain level meter.

The Audition button above the Audition Level slider lets you listen to the filtered and stereo-linked signal that
will be used to trigger compression. You can turn Audition mode on or off with a single click, but you can also
click-and-hold the button to temporarily audition the trigger signal. Note: audition can only be used when
triggering on the internal audio or external side chain.

The Side Chain Input selector chooses what the compressor triggers on. By default (Internal), it triggers on
the main input audio of the plug-in, but you can also select External to trigger on the external side chain input.
For more information on connecting the external side chain in various hosts, see External side chaining.

New in Pro-C 3 is the Host Sync option, which makes compression trigger on a generated pulse, synched to
host tempo. When you select this, a panel with additional settings appears: the Sync button sets the speed
(relative to the song tempo) at which the pulse is generated. With the Offset slider, you can adjust the sync
speed with a factor between 50% and 200%, which makes it possible to achieve dotted or triplet effects. The
Length slider sets the length of the pulse, as a percentage of the current sync setting.

Finally, you can trigger on incoming MIDI note on messages, so you can create custom trigger patterns in your
DAW. If at least one note is on, the compressor behaves as if a 0 dBFS signal is entering the side chain at this
moment, so it is strongly triggered. See MIDI Learn on how to route MIDI to an effect plug-in in your DAW.

Stereo linking and M/S processing

The first half of the Stereo Link knob sets stereo linking from 0% (fully unlinked, channels operate independently) up
to 100% (fully linked, resulting in the same gain reduction for both channels).

By turning the knob beyond 100%, Pro-C 3 will eventually process only the mid-signal (mono content of the processed
audio), or only the side-signal (stereo content of the processed audio). (If you'd like to learn more about mid/side
processing and its various uses, see our Mid Side Demystified  video tutorial by Dan Worrall.)

Using the small Stereo Link Mode button at the right bottom of the Stereo Link knob, you can choose between four
options. With the knob at its maximum position, this will be the result:

Mid - Only trigger on, and apply compression to, the mid signal.

Side - Only trigger on, and apply compression to, the side signal.

M>S - Trigger on the mid signal but only apply compression to the side signal.

S>M - Trigger on the side signal but only apply compression to the mid signal.

15

file:///Users/florisklinkert/Documents/FabFilter/Projects/Pro-C/Help/Html/support/externalsidechaining.html
file:///Users/florisklinkert/Documents/FabFilter/Projects/Pro-C/Help/Html/using/midilearn.html
https://www.fabfilter.com/video/mid-side-demystified


M/S processing can be very useful, especially during mastering. For example, bass or lead vocals are often placed in
the center of the stereo image, so only processing the mid-signal will leave all stereo content untouched, ensuring the
most transparent end result possible.

To better understand the working of these settings, enable the Audition button. You can now directly hear the effect of
stereo linking and mid-only or side-only processing!

When using Pro-C 3 for surround/immersive audio processing, the Stereo Linking section will offer slighly different
controls, tailored especially to deal with surround channels. See Surround and Dolby Atmos. Of course, in the mono
version of the plug-in, the Stereo Linking controls are simply disabled.

Side chain EQ controller

The large interactive EQ controller takes up most of the side chain section, and enables you to easily adjust the side
chain filtering. You can freely add up to six EQ bands, with all the shapes you already know from Pro-Q, including All
Pass filters. The low- and high pass filters support slopes up to 96 dB/oct and also the Brickwall slope.

Creating bands

To add a new EQ band, simply click on the yellow overall curve and drag it up or down. You will see a small
preview of the type of curve that will be created when you start dragging.

Alternatively, double-click anywhere in the display background to add a new band. The shape of the newly
created band depends on where you create it.

Selecting bands

Click the EQ band's dot or the colored area around it to select it.

Click and drag on the display background to select adjacent bands by dragging a rectangle around them.

Hold down Ctrl (Command on macOS) and click another dot to select multiple bands. Hold down Shift and
click a dot to select a consecutive range of bands.

Deselect all bands by clicking anywhere on the display background.

Adjusting and editing bands

Once you have selected one or more EQ bands, the display highlights the shapes of the selected bands. To edit the EQ
settings:

Click and drag a selected dot to adjust the frequency and gain of all selected bands. If you have multiple bands
selected, the gain of all selected bands will be scaled relative to each other.

Move the mouse wheel to adjust the Q setting, making the selected bands narrower or wider. This works while
dragging or when the mouse pointer is above a curve. For low/high cut filters, the mouse wheel adjusts the
slope instead, setting it to stepped values.

Alternatively, adjust the Q of all selected bands by holding down Ctrl (Command on macOS) while dragging
vertically.

Move the mouse wheel while holding down Alt to adjust the dynamic range setting or Ctrl (Command on
macOS) to adjust the gain.

Hold down Shift while dragging (or while using the mouse wheel) to fine-tune the settings of the selected
bands.
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Hold down Alt while dragging to constrain to horizontal adjustments (frequency) or vertical adjustments (gain
or Q, depending on the Ctrl/Command key).

Hold down Alt and click the dot on an EQ band once to toggle its bypass state (enabling or disabling the band).

Hold down Ctrl+Alt (Command+Alt on macOS) and click the dot on an EQ band once to change its shape.

Hold down Alt+Shift and click the dot on an EQ band once to change its slope.

Double-click a dot to enter values in the EQ parameter display (using the Tab key to step through
Frequency, Gain and Q) or double-click the values in the parameter value display directly. Note that you can
enter frequencies in various ways, like "100", "2k", "A4" or "C#2+13".

If you right-click on the dot for an EQ band, a pop-up menu appears with various band settings. This is a quick
way to modify the EQ band while you're working in the display.

You can choose a stereo placement for a band (stereo, mid or side) or specify which speakers it affects (only
in surround mode) from the band menu, which you can open by either right-clicking a band's dot in the display,
or clicking the menu button in the parameter value display of a band.

Copying and pasting bands

You can copy any band or selection of bands by right-clicking on a curve dot, and choosing Copy from the curve
menu. Now, you can paste these band in any Pro-C 3 instance by right-clicking anywhere in the side chain controller,
and choosing Paste from the menu that appears. To copy all bands, right-click on the background and click Copy from
this menu.

To copy and paste all Pro-C parameters, use the Copy and Paste commands in the preset browser.

EQ parameter display

Next to each EQ band's dot in the side chain controller, the EQ parameter display shows the exact parameter values
for the EQ band, along with quick controls to bypass or delete a band and change its shape. You can double-click a
value in the display directly to edit it. You can also click-and-drag or use the mouse wheel above any of the shown
parameters to make changes on a band or selection. Click the triangular menu button to access the band menu with
more options.

Tips

To learn more, read the Side chain compression  article in our online FabFilter Learn tutorials.

In Full Screen mode, available via the button at the right top of the interface, Pro-C 3 will fill the whole screen,
making the side chain EQ controller much larger as well, so you can make very precise adjustements. See Full
Screen mode and resizing.

When using MIDI triggering, make sure that you have the Disable/Enable MIDI option in the MIDI Learn menu
turned on.

The spectrum analyzer of the side chain EQ controller uses a 4.5 dB/oct tilt setting. This results in a natural
looking spectrum, resembling best how loudness is perceived by the human ear.

Next: Displays and metering

See Also
Using FabFilter Pro-C 3
Dynamics controls
Time controls
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Displays and metering
FabFilter Pro-C 3 features a large animated level display with an optional knee display on top of it, and precise input,
gain reduction and output metering.

Knee display

The knee display shows the input/output relationship, visualizing the Threshold, Ratio, Knee and Range settings. The
horizontal axis of the display corresponds to the input signal level, and the vertical axis is the output level, both in dB.
When running audio through the plug-in, the white transfer curve will turn green, indicating the current input level.
You can choose to show or hide the knee display using the Knee button at its right-hand border. Once you've chosen a
setting, new instances of the plug-in will always open this way.

Note that knee display, level display and level meters all use the same meter scale, which makes it easier than ever to
find the proper compression settings. The scale can be adjusted using the meter scale button at the right bottom of
the interface (next to the level meters). Once you've chosen a setting, new instances of the plug-in will always open
with the selected meter scale.

Level display
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The top part of Pro-C 3 forms a large animated level display, with the main compression controls floating above it. The
level display visualizes the input and output level, together with the applied gain change. The input is shown in dark
grey, whil the output is light grey with a light stroke, which makes it easy to see the exact effects of the applied gain
reduction. The gain reduction itself is shown as a red line.

If you'd like to have as little distraction as possible when working with Pro-C 3, you can choose the Compact layout
via the Resize button at the bottom right of the interface. This will hide the level- and knee displays, and just show
horizontal level meters. This way, Pro-C 3 looks and feels more like a traditional compressor. Once you've chosen a
certain interface size, new instances of the plug-in will always open this way.
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Peak level and loudness level metering

At the right of the interface, there are accurate peak level meters that display the current gain reduction and output
levels. The read-outs above the level meters show the highest measured peak value. Click the readout to reset it. To
show the optional input level meter, click the Show Input Level option on the Help menu.

The input and output meters also show the loudness level (per channel) on top of the peak level. The loudness level
complies with the Momentary mode of the EBU R128 / ITU-R 1770 standards. The peak indicators floating above the
loudness levels show the combined Momentary loudness of all channels together.

Notes

When using Pro-C 3 in surround/immersive mode, the input meters will simply never be shown, as they take up
a lot of interface space.

You can change the scale of the displays and level meters using the meter scale drop-down button, ranging
from 9 dB (for precise mastering purposes) to 90 dB (general mixing and bus processing).

If the level meters indicate clipping, this does not imply distortion in Pro-C 3: it can handle levels above 0 dBFS
easily. Rather, this indicates that the signal might clip in another part of the audio chain, for example your sound
card or host software. Click at the top of a meter to reset its clipping indication.

Next: Oversampling

See Also
Dynamics controls
Input and output options
Using FabFilter Pro-C 3
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Oversampling
The dynamics algorithms often need to make very quick changes to the audio when applying gain change. These
sudden changes can introduce a small amount of aliasing, which causes distortion and generally reduces the quality
of the audio signal. Oversampling is a way to reduce that aliasing by running the internal process at a sample rate that
is a multiple of the host's sample rate.

"When do I need to turn on oversampling?"

You need it more when the compression is more aggressive and apparent. Usually, this is the case when using lower
Attack and Release and/or higher Ratio and Range settings, or when you have a character mode enabled and are
driving the circuit significantly. Of course, in return for a reduction of possible aliasing/distortion, the plug-in will use
more CPU power when using oversampling. In addition, oversampling introduces a small latency, in addition to
lookahead latency.

"Which oversampling factor do I choose?"

Above all, we recommend that you use your ears; don't just enable oversampling because you assume that's always
better. If you think oversampling could improve the sound, start with 2x or 4x and see if that is enough. The higher
oversampling factors will significantly increase CPU usage of the plug-in, and should only be used when absolutely
needed.

Tips

Do you need to use zero-latency processing? Set Oversampling and Maximum Lookahead to Off in the bottom
bar.

Next: Full screen mode, resizing and scaling

See Also
Using FabFilter Pro-C 3
Dynamics controls
Time controls
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Full Screen mode, resizing and scaling
With just the click of a button, the Pro-C 3 interface will fill up the whole computer screen so you can make ultra-
precise adjustments and get the best view on the spectrum analyzer and filter display. To exit Full Screen mode, just
press Escape or click the Full Screen button again.

Resizing

In addition to Full Screen mode, you can also customize the normal interface size using the Resize button at the right
of the bottom bar. You can choose between Compact, Small, Medium (the default size) or Large. Once you have
selected a size, it will automatically become the default size for new plug-in instances.
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Scaling

At the bottom of the resize menu, the Scaling submenu lets you increase or decrease the interface scaling relative to
the system default, e.g. 150% (smaller) or 300% (larger) on Retina monitors (that have a 200% scaling by default).

When you enable Full Screen mode, the plug-in will automatically choose an appropriate scaling so that all controls
become a bit larger. The plug-in automatically remembers the chosen scalings for normal and Full screen mode, and
also per monitor type (Retina / High DPI or regular), so once you've customized the settings to your preference, you
don't have to worry about it anymore.

Tips

When using the VST3 plug-in, you can resize the plug-in interface by just dragging the window edges to any size
you like. Of course you can always go back to one of the predefined sizes with the resize button.

The large interface options will be greyed out in the Resize button menu if the current display is too small to
support them, and the same applies to the scaling options.

Next: Surround and Dolby Atmos

See Also
Using FabFilter Pro-C 3
Side chain section
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Surround and Dolby Atmos
FabFilter Pro-C 3 supports all important surround/immersive audio formats, up to 9.1.6 Dolby Atmos (depending on
the DAW and plug-in format). When you add Pro-C 3 to a surround channel, the interface automatically adapts itself to
the used multi-channel format. The output level meter will show all channels, with appropriate labels to identify them.

In addition, the Stereo Linking section in the Side chain section will have additional surround functionality.

Stereo linking in surround instances

When using Pro-C 3 on a surround track or bus, the first half of the range (from "0% Stereo" to "100% Stereo"), the
Stereo Link knob works the same as in the stereo version of the plug-in: it controls the amount of linking between L
and R channels (e.g. L/R, Ls/Rs, Lc/Rc or Lts/Rts). However, every stereo pair's linking is still independent of the other
stereo pairs.

In the second half of the range (from "100% Stereo, 0% All" to "100% Stereo, 100% All"), all channels will interpolate
to full all-channel linking, where every channel triggers on the same signal: the maximum of all channels.

In addition, a C and All button are available:

With the C button enabled, the center channels (C, Cs) will be included in the linking of their associated L/R
stereo pair, i.e. C is linked to L/R and Cs to Ls/Rs. When leaving it disabled (which it is by default), the center
channels will always stay unlinked and operate fully independent from all other channels.

The All button opens a menu where you can toggle groups of speakers (Sides and Tops and LFE), to be
included in, or excluded from the all-channel linking in the second half of the range. When leaving an option
unchecked, these channels will always stay unlinked and operate fully independent from other channels. The LFE
option is disabled by default. If any setting is customized here, the All button will light up red to indicate this.

Notes

Input/Output panning and Dry/Wet panning are not available when using Pro-C 3 in a surround layout. We
recommend to change surround channel levels using a dedicated surround panning plug-in.

Next: Instance list

See Also
Overview
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Instance list
Pro-C 3 is now part of the instance list ecosystem of Pro-Q 4. In Pro-Q 4, you can open the instance list by clicking on
the instance button at the center of the bottom bar. In this view, you can see and edit all instances of Pro-Q 4, Pro-C
3, Pro-DS and Pro-G (more plug-ins will follow) in your session, organized per track. It's like having a custom, multi-
track channel strip plug-in. You can set up a whole mix without leaving the Pro-Q 4 window!

Here's how it works:

In Pro-Q (since version 4.10), the instance list now shows Pro-Q 4, Pro-C 3, Pro-G and Pro-DS instances
(more plug-ins will follow), and instances are organized per track

Instances will order themselves according to how they are inserted on the track on start/stop in your DAW.

Every plug-in can be easily bypassed, using the Bypass button at the left top of the instance item, shown
when hovering above instance item.

Instances offer functionality according to the zoom level (zoom slider at the top). At the smallest levels,
plug-ins only show only a few essential controls. At the largest levels, you can edit almost all plug-in
parameters.

Clicking on the instance background (or using the enlarge button at the left top at higher zoom levels) will zoom
the whole track to the maximum zoom level for easy editting. Clicking anywhere on the list background will
zoom out to the general zoom level again.

You can acces the instance's preset menu and load plug-in presets, or copy and paste plug-in settings via the
menu button at the right, visible when hovering over the instance item.

Learn more about the instance list in the Pro-Q help file .

Next: Input and output options

See Also
Dynamics controls
Using FabFilter Pro-C 3
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Input and output options
At the righthand side of the bottom bar in the interface, FabFilter Pro-C offers a set of global output options.

The Global Bypass button lets you bypass the entire plug-in. While most hosts already provide the ability to bypass
plug-ins, our internal global bypass feature is guaranteed to work correctly when using lookahead or oversampling
(compensating for the latency of the plug-in) and also applies soft bypassing to avoid clicks. While the plug-in is
bypassed, the display dims and a red line at the top of the bypass button appears.

As soon as you hover the mouse above the output option button, right next to the bypass button, a panel with various
options and large output/pan knobs will pop up, giving you access to the following settings:

The Input Level/Pan knob at the left adjusts the level and L/R panning of the input signal before any
processing is applied. You can use this as an alternative to changing the threshold.

The Output Level/Pan knob at the right adjusts the level and L/R panning of the final output signal. This lets
you compensate globally for any gain added or removed by dynamics processing.

The Mix slider enables you to mix between the dry and processed signals, scaling the overall dynamic and static
gain changes. Because the Mix slider ranges from 0% to 200%, you can also choose to increase overall gain
processing instead of fading it out!

Tips

You can directly adjust the mix, input gain or output gain by clicking and dragging the button text vertically. You
can use your mouse wheel while hovering over the button text or double-click it to directly enter a value using
the keyboard.

If desired, you can make the output options panel 'sticky' by clicking the output button once. Click it again to
hide the panel.

By holding down the Alt key (Shift key in Pro Tools) while dragging, input and output level can be adjusted
simultaneously in the opposite direction.

Next: MIDI Learn

See Also
Using FabFilter Pro-C 3
Knobs
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MIDI Learn
Controlling FabFilter Pro-C 3's parameters directly with MIDI is very easy using the MIDI Learn feature. With MIDI
Learn, you can associate any MIDI controller with any parameter.

Click the MIDI Learn button in the bottom bar to enter MIDI Learn mode. The interface dims and the parameters that
can be controlled are highlighted. Each parameter has a small text balloon that displays the associated controller
number. Now do the following to associate a controller number with a parameter:

1. Touch the control of the desired parameter in the interface that you wish to control. A red square will mark
the chosen parameter.

2. Adjust the slider or knob on your MIDI keyboard or MIDI controller that you want to associate with that
parameter.

That's it! The parameter will now be controlled with the MIDI controller. You can now go back to step 1 to associate a
different parameter. Note that there is no warning when you associate a different knob with a controller number that is
already used. It will just be replaced.

To exit MIDI Learn mode, click the MIDI Learn button again, or click Close at the top of the interface.
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Click the small menu drop-down button next to the MIDI Learn button to access the MIDI Learn menu:

Enable MIDI
This globally turns MIDI control of parameters on or off: useful in hosts that automatically send all MIDI events
on a track to all effect plug-ins associated with that track as well.

Clear
This submenu shows all parameter associations and lets you delete individual associations or clear all
associations in one step.

Revert
Reverts to the last saved MIDI mapping (or the state when the plug-in was started).

Save
Saves the current MIDI mapping so Revert will go back to this state. The current mapping is automatically saved
when closing the plug-in.

Routing MIDI to effect plug-ins

For MIDI Learn to work properly, the plug-in need to actually receive MIDI of course. Depending on your host, it can
be quite difficult to route MIDI data to effect plug-ins. Here's how to do it in the most important hosts:

Pro Tools
Create a new MIDI track. From the MIDI input drop down menu, choose your MIDI device (if not already
selected) and from the MIDI output drop down menu, choose FabFilter Pro-C 3 -> channel 1 for the instance you
would like to control.

Logic Pro
Instead of adding FabFilter Pro-C 3 to one of the insert slots, create a new Instrument Track, and click on the
Instrument slot. Then choose AU MIDI-controlled Effects > FabFilter > Pro-C 3. Now, the plug-in receives
MIDI. To get audio into the plug-in, click the 'Side Chain' drop down menu in Logic's plug-in header and choose
the actual input track. Next, you can mute that original track, so you only hear the audio through the plug-in.
The only downside is that plug-ins with an external side-chain cannot use it anymore.

Ableton Live
First of all, create a new MIDI track. From the 'MIDI from' drop down menu, choose your MIDI device (if not
already selected). Then, in the 'MIDI to' drop down menu, choose the Audio track that has FabFilter Pro-C 3 on
it. Note: only the first plug-in on any track can receive MIDI.

Cubase
Simply create a new MIDI track and set its output to the Pro-C 3 instance you would like to control via MIDI.

Tips

Compression is also triggered by MIDI notes. If at least one note is on, the compressor behaves as if a 0 dB
signal is entering the side chain at this moment, so it is strongly triggered. The Disable/Enable MIDI option in
the MIDI Learn menu turns this off as well.

Next: Undo, redo, A/B switch
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Undo, redo, A/B switch
The Undo and Redo buttons at the top of the FabFilter Pro-C 3 interface enable you to easily undo changes you made
to the plug-in. With the A/B feature, you can quickly switch between two different states of the plug-in.

The Undo button at the left will undo the last change. Every change to the plug-in (such as dragging a knob or
selecting a new preset) creates a new state in the undo history. The Undo button steps back through the history
to restore the previous states of the plug-in.

The Redo button cancels the last undo command. It steps forward through the history until you are back at the
most recent plug-in state.

The A/B button switches from A to B and back. Before switching, the current state of the plug-in is saved, so if
you click this button twice, you are back at the first state. The button highlights the currently selected state (A
or B). In the example above, the A state is active.

The Copy button copies the active state to the inactive state. This marks the current state of the plug-in and
allows you to go back to it easily with the A/B button. After clicking Copy, the button disables itself to show that
both states are equal, so there is nothing to copy anymore.

Notes

If the plug-in parameters are changed without using the plug-in interface, for example with MIDI or automation,
no new undo states are recorded.

The Undo and Redo buttons will disable themselves if there is nothing to undo or redo.

Next: Using on iOS

See Also
Using FabFilter Pro-C 3
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Using on iOS
FabFilter Pro-C 3 is available as an AUv3 plug-in for iPad in the App Store. Using
Pro-C 3 on a touch screen is slightly different from using it with a mouse:

To adjust a knob, just touch it and drag up or down.

For fine adjustment, hold down a second finger while you're dragging a knob.

To reset a knob to its default position, simply double-tap it.

To type a new value directly, press and hold on a knob until the on-screen
keyboard appears. Note that the keyboard might obscure the parameter value
display — unfortunately we can't do anything about that because an AUv3
plug-in cannot control its own position on the screen.

Unlike the regular plug-in, the AUv3 plug-in offers no resizing or full screen mode
from the plug-in interface itself: this must be provided by the host app.

To organize presets on iOS, open the preset browser and swipe to the left on any preset or subfolder to see options to
delete or edit it. When editing a preset or folder, you can rename it and move it to another folder.

The Pro-C 3 app that contains the AUv3 plug-in serves as a stand-alone host that simply routes audio from the
microphone to the plug-in and plays it back in real-time via the speakers or headphone output. You need to manually
start the audio engine using the Audio On/Off switch at the bottom, but first make sure that the speaker volume is not
too high to avoid excessive feedback! We do recommend to use an AUv3 host app like Auria, Cubasis, AUM or
GarageBand to take full advantage of Pro-C 3's features.

View FabFilter iOS plug-ins in the App Store 

Using Pro-C 3 in the Pro-Q 4 instance list

At the moment, the AUv3 plug-in of Pro-C 3 will not appear in the instance list of Pro-Q 4 on iOS, due to technical
reasons. The Pro-Q 4 AUv3 instance list will only show Pro-Q instances, and cannot show other plug-ins yet. However,
we are working on implementing this in the future.

Next: Loading presets

See Also
Overview

31

file:///Users/florisklinkert/Documents/FabFilter/Projects/Pro-C/Help/Html/presets/loadingpresets.html
https://www.fabfilter.com/ios
file:///Users/florisklinkert/Documents/FabFilter/Projects/Pro-C/Help/Html/presets/loadingpresets.html


Loading presets
Plenty of presets are provided with FabFilter Pro-C 3, giving a good idea of what you can do. You can either use the
presets as they are, or tweak them further to create your own unique settings.

The preset button shows the name of the current preset. If you have changed the preset by adjusting one or more
parameters, the name is dimmed to indicate that this is not the original preset anymore.

Click the preset button to open the preset browser:

The preset browser shows all presets grouped in folders, with the current preset highlighted in blue.

Preset details

A preset can contain extra information: author, tags and a description, which is shown in the panel on the right.
These fields are present in all factory presets and can of course be edited as well: just double click the author or
description. To add a tag, click the + button. Double-click a tag to rename it, or hover over the tag and click the x
button to remove it.

Browsing presets

You can browse and select presets in various ways:

Of course, you can simply browse using the mouse. Hover over folders to open them, and click on a preset to
load it. If you move the mouse outside the browser after selecting a preset, the browser will close. Otherwise, it
will stay open so you can look around and try multiple presets, or edit their information.

Within the preset browser, you can use the arrow keys to navigate, and the Enter key to load a preset and
close the browser. Use the right arrow key to load a preset without closing the browser. Press the Esc key to
close the browser without selecting anything.

You can also click the previous/next arrow buttons around the preset button to explore presets one by one
without opening the preset browser.

... and while the browser is open, use the [ and ] keys to load the next or previous preset directly.
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Searching, filtering and favorites

In the preset browser, you can start typing to search through the presets, filtering on folder name, preset name or
tag. While typing, the preset browser automatically filter the current selection and update itself to show the resulting
sub set. If you've first started browsing by mouse, just click the Search field and type to start filtering again.

You can also mark presets as favorite, by clicking the star icon next to the preset name in the preset details panel.
Click the star icon next to the Search field to show only your favorites.

Copy or paste presets

You can copy the current settings of the plug-in and paste it into any plug-in instance you like. You can either open the
preset broswer and use the Copy or Paste item at the bottom, just above the Save As item. Or you can right-click
on the preset button, and use the menu that pops up.

Preset browser options

Click the Options button  at the left of the search field at the top to open a menu with extra options:

When Type To Search is enabled, you can start typing to search, right after you've clicked the preset button.
Disabling this will always require a click in the Search field to start searching. This might be handy, for example
if you're working without a MIDI keyboard and use letters on your computer keyboard to play notes.

When Enable MIDI Program Changes is active, you can load presets via MIDI program change and bank
select messages. The corresponding bank/program numbers are then shown in front of the preset name (for
example: (0/65) My Preset). This means that you can load that preset by first sending a Bank Select message to
select bank 0 and then sending a Program Change message to select program 65.

Important: All the presets in your preset folder are numbered automatically, starting with bank 0 and program
0. This way, you are able to access any of the presets via MIDI. However, this also means that when you add
new presets to the menu, bank/program numbers of other presets might change. Be aware of this when
recording program changes in a session! We recommend to create a dedicated folder in your presets folder for
your program changes, and name it with two leading underscores (e.g. "__Programs") to ensure it's the first
folder in your preset collection and the presets in this folder start with bank 0 and program 0.

The Default Setting preset is loaded automatically when FabFilter Pro-C 3 is started. To change the default
settings, simply overwrite this preset by clicking Save As Default.

To open a preset outside the presets folder, click Open Other Preset. This might be useful if someone sends
you a preset by email, for example.

To change the location where the presets for Pro-C 3 are stored, choose Change Preset Folder and select the
desired folder.

If somehow the factory presets are lost or not installed properly, click Restore Factory Presets to restore
them.
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If needed, for example after you've manually removed or added files in the folder while Pro-C 3 is open, click
Refresh to rescan the preset folder.

Next: Saving presets

See Also
Using on iOS
Undo, Redo, A/B switch
Using FabFilter Pro-C
Acknowledgements
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Saving presets
You can easily extend the included presets with new settings to build your own library of presets for FabFilter Pro-C 3
that you can reuse in various projects. This is also a good way to copy settings across multiple instances of FabFilter
Pro-C 3 in a session.

To save the current setting as a preset, click the preset button, and then click Save As. A standard Save dialog will
appear. Type a name for the new preset and click Save to finish.

In the Save dialog, you can also rename and delete existing presets and create a new folder to store presets in. New
folders will show up as new categories in the preset menu. (On macOS, this should be done with the Finder.)

Right-click shortcut menu

You can also right-click on the preset button to open a small menu with shortcuts:

Favorite: Mark the current preset as favorite.

Save: Overwrite the currently loaded preset. You will be asked for confirmation before saving.

Save As: Just like choosing the 'Save As...' item from the main menu.

See How presets are stored to determine the preset folder location and learn more about factory presets.

Next: How presets are stored

See Also
Loading presets
Using FabFilter Pro-C
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How presets are stored
Presets for FabFilter Pro-C 3 are stored in separate files with the .ffp extension (for FabFilter Preset). All presets reside
in subfolders in the main preset folder. The subfolders will show up as separate categories in the preset menu. You can
also further divide the subfolders into categories.

You can manage the preset files just like other files on your computer. The easiest way to do this is in the Save dialog
that appears if you are saving a preset. The preset menu will automatically reload itself with the changes when the
dialog is closed.

Furthermore it is very easy to share your newly created presets with other users since FabFilter presets use the same
file format on both Windows and macOS.

The default location of the main preset folder is Documents/FabFilter/Presets/Pro-C 3 on both Windows and macOS. To
change this location, first copy all presets to the desired new location. Click Options  and Change Preset Folder in
the preset browser and select the new folder.

Note: previously on macOS, presets were stored in ~/Library/Audio/Presets/FabFilter/FabFilter Pro-C 3. To determine
the current location of the presets folder, click Options  and Change Preset Folder in the preset browser.

Restoring factory presets

If you have accidentally lost the factory presets, you can easily restore them by clicking Options  and Restore
Factory Presets in the preset browser. This will install all factory presets again.

Next: Purchasing FabFilter Pro C

See Also
Saving presets
Using FabFilter Pro C

36

file:///Users/florisklinkert/Documents/FabFilter/Projects/Pro-C/Help/Html/purchase/purchase.html


Purchasing FabFilter Pro-C
Once you have downloaded and installed the evaluation copy of FabFilter Pro-C 3, you may evaluate it during 30 days.
Every time you start the plug-in, you will see the following dialog:

While there are still days left, you can click Evaluate to start working with the plugin. If you want to keep using
FabFilter Pro-C 3 after the evaluation period, you must buy a copy in the online FabFilter Shop by clicking the Buy
Now button in the evaluation dialog.

Go to the FabFilter Shop and purchase FabFilter Pro-C 3 now 

We accept a wide range of payment methods, like credit cards, PayPal, wire transfer and iDeal. The FabFilter Shop
uses secure connections and encryption: therefore your personal information is completely safe.

Within a few minutes after you have purchased your copy, you will receive an email containing your personal license
key. You use this license key to turn the evaluation copy into a fully registered version without the evaluation dialog
and the 30-day trial restriction. In addition, we will automatically create a FabFilter account  for you (if you don't
have one already). Here, you can access all your license keys at any time.

Note: If the evaluation period has expired but you didn't have the chance to properly evaluate the plug-in, you can
request a new evaluation period by contacting us at info@fabfilter.com .

Next: Entering your license key

See Also
Support
License agreement
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Entering your license key
After you have purchased FabFilter Pro-C 3 in the online FabFilter Shop , you will immediately receive an email
containing your personal license key. This license key will turn the evaluation version into a fully registered plug-in.

Start FabFilter Pro-C 3 and click Enter License in the evaluation dialog, or click Enter License on the Help menu
if the plug-in is already running.

Copy the license information from the email you have received and paste it into the text field. Make sure that
you are copying the entire license key including the Product and Licensee lines! If you are not sure what text to
copy, just copy and paste the whole email.

After you have entered your license information, you will need to restart the plug-in host, so make sure you save your
settings if needed. From now on, you will be able to use FabFilter Pro-C 3 for an unlimited period of time with full
support via email.

Tips

After your purchase, you can always retrieve your license key again by logging into your personal FabFilter
account . Here you can also keep track of all your orders and take advantage of great discounts when buying
other FabFilter plug-ins.

To deauthorize your license key and remove it from the computer, click Deauthorize on the Help menu. If you
temporarily needed to install your license on another computer, or if you have transferred your license to
someone else, this is the way to deinstall your personal license key safely.

Next: Support

See Also
Purchasing FabFilter Pro-C
Support
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Support
If you need help with problems or questions, and the help file does not provide an answer, please visit the support
pages on our web site.

Go to FabFilter Support 

From here, you have direct access to the customer support forum, very useful tutorial videos for all FabFilter plug-ins,
online and PDF versions of all our help files, and a section with extra downloads (such as presets, controller templates,
older plug-in versions).

For sales-related questions and technical support, you can also contact FabFilter directly at info@fabfilter.com.

Reporting a bug

If you have encountered a bug in FabFilter Pro-C 3, first of all make sure that you are using the latest version of the
plug-in, which you can find at www.fabfilter.com/download . You can easily check the version of FabFilter Pro-C 3
that you are using by clicking Help > About in the plug-in interface. If the bug is still present in the latest version,
please send us an e-mail at info@fabfilter.com and include as much technical information as possible: operation
system and version, host software and version, steps to reproduce the bug, etc. Thanks in advance!

Next: Upgrading to Pro-C 3

See Also
Using FabFilter Pro-C
Acknowledgements
About FabFilter

39

https://www.fabfilter.com/support/
mailto:info@fabfilter.com
https://www.fabfilter.com/download/
mailto:info@fabfilter.com
file:///Users/florisklinkert/Documents/FabFilter/Projects/Pro-C/Help/Html/support/upgrading.html
file:///Users/florisklinkert/Documents/FabFilter/Projects/Pro-C/Help/Html/support/acknowledgements.html
file:///Users/florisklinkert/Documents/FabFilter/Projects/Pro-C/Help/Html/support/about.html


Upgrading to Pro-C 3
Upgrading from Pro-C version 2 or 1 to the new Pro-C 3 is safe and easy: installing Pro-C 3 will not replace or delete
the previous Pro-C plug-in versions. Different major versions will co-exist and can be used at the same time. This
ensures that you can open old songs that use Pro-C 2 without problems.

Presets from version 2 or 1

All presets created with Pro-C 2 or 1 can be loaded in Pro-C 3. If you upgraded to the new version, your original
presets v2 and v1 presets will be accessible via the V2 Preset Folder and V1 Preset Folder items in the preset
menu. See also Loading presets.

Replacing a Pro-C 2 or 1 instance by Pro-C 3

If you are working on a song and want to replace an earlier Pro-C version instance with the new Pro-C 3, we advise
you to do the following:

First, save the current setting of the instance as a FabFilter preset in the preset folder of that Pro-C version.

Then, remove the old Pro-C instance and add Pro-C 3 in its place.

Finally, load the preset that you just created into Pro-C 3 via the V2/1 Preset Folder submenu in the preset
menu.

Automation

Because the feature set of Pro-C 3 has changed fundamentally, any automation data that has been written by a Pro-C
2 or Pro-C 1 instance cannot be read correctly by Pro-C 3.

Note: We are in contact with developers from all plug-in frameworks to implement a way of properly replacing old Pro-
C instance with new Pro-C 3 instances, including the translation of automation data, but sadly this is not possible yet
at the moment.

Next: Manual installation

See Also
Overview
Support
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Manual installation
When installing FabFilter Pro-C 3, the installation program will try to copy the plug-in into the appropriate plug-ins
folders, and in most cases your host will recognize FabFilter Pro-C 3 automatically. Otherwise, please follow these
instructions:

Windows

On Windows, most hosts have their own VST plug-ins folder. So if you are using Windows and your host does not
recognize FabFilter Pro-C 3, you need to locate the proper plug-ins folder for your host first (it is usually shown in the
Preferences or similar dialog). Then, copy the file FabFilter Pro-C 3.dll from C:\Program Files\FabFilter\Pro-C 3 (or
C:\Program Files (x86)\FabFilter\Pro-C 3 if you are using a 32-bit host on 64-bit Windows) to the plug-ins folder that
you have found and restart the host so it can reload all its plug-ins. The VST3, CLAP, and AAX plug-ins are installed in
the standard plug-in folders on your computer.

You can simply uninstall plug-ins or bundles via the Control Panel.

macOS

On macOS, plug-ins are installed in the standard plug-in folders in the system Library folder. These are the only
possible correct locations:

Audio Units: /Library/Audio/Plug-Ins/Components

VST/VST3: /Library/Audio/Plug-Ins/VST and /Library/Audio/Plug-Ins/VST3

CLAP: /Library/Audio/Plug-Ins/CLAP

AAX: /Library/Application Support/Avid/Audio/Plug-Ins

Note: AU and VST/VST3 plug-ins may also be placed in the user's Library folders under
/Users/<username>/Library/Audio/Plug-Ins.

To uninstall the plug-ins from your Mac, you can just delete the specific FabFilter plug-in files at the above locations.
Finally, if you really want to delete all data written by our plug-ins, you can remove the following folders/files as well:

/Users/<username>/Documents/FabFilter/Presets/Pro-C 3

/Users/<username>/Library/Audio/Presets/FabFilter/FabFilter Pro-C 3

/Users/<username>/Library/Application Support/FabFilter/Pro-C 3

/Users/<username>/Library/Preferences/com.fabfilter.Pro-C.3.plist

Note: Since OS X 10.7 (Lion), the system and user Library folders are marked as hidden by default. To make them
visible again in Finder, open Terminal (found in /Applications/Utilities) and enter the following commands:

chflags nohidden /Library
chflags nohidden ~/Library

If you still have problems, contact FabFilter Support .

Next: VST Plug-in versions
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VST plug-in versions
FabFilter Pro-C 3 is available in both VST 2 and VST 3 formats. They can be installed and used both at the same time.
The VST 3 format offers easy side-chaining, free interface resizing, and is more CPU-friendly in some cases, but it can
only be used by hosts that support it, for example recent versions of Cubase, Studio One or FL Studio. The VST 2
format is compatible with a larger variety of hosts.

Both the VST 2 and VST 3 versions of the plug-in automatically adapt themselves to the channel layout of the track
they are inserted on (mono/stereo and surround).

Next: External side chaining

See Also
Quick start
Manual installation

42

file:///Users/florisklinkert/Documents/FabFilter/Projects/Pro-C/Help/Html/support/externalsidechaining.html


External side chaining
FabFilter Pro-C 3 offers the possibility of feeding an external signal to its side chain, so that you can make it trigger on
a different signal than the audio it is actually processing. Feeding a signal to a plug-in's side-chain inputs works
slightly different in various hosts. This topic describes the procedure for some of the most popular hosts around: Pro
Tools, Studio One, Ableton Live, Logic Pro and Cubase.

To explain how it works, we use a scenario with two tracks. The first one contains the audio that we want to process
with Pro-C 3, which we'll call the main track from now. The second track contains the audio that we want to route to
Pro-C 3's external side-chain input and use as trigger signal. We'll call this track the side chain track.

After setting up everything according to the instructions below for your host, you can check whether everything is
routed correctly. Play the audio and enable FabFilter Pro-C 3's Audition button to listen to the side chain signal. While
auditioning, the real-time display and metering show the side chain level, so you can easily set a correct trigger
threshold. Afterwards, disable the Audition mode again. Now, you'll hear that Pro-C 3 on the main track will react to
the sound of the side chain track. Of course, you can fine-tune the plug-ins settings to customize the effect.

Pro Tools

Open Pro Tools and start a new empty session.

Create two audio tracks that we'll use as main track and side chain track. Add audio files to both track.

Open the Mix window to display the tracks with their Insert slots and Sends slots.

In the first 'Sends' slot of the side chain track, choose 'Bus 1'. The track view for Bus 1 will open: set its level
slider to 0.0 dB so the bus actually produces audio!

In the first 'Inserts' slot of the main track, choose Dynamics > FabFilter Pro-C 3.

Open FabFilter Pro-C 3's interface, enable Expert / Side Chain mode, and set Side Chain to Ext.

Now, in the 'Key Input' menu of the plug-in interface (just above the FabFilter logo), choose bus > Bus 1 instead
of the default 'no key input'. Now, the audio from the side chain track is routed to Pro-C 3's external side chain
input via Bus 1.

Studio One

Open Studio One and choose 'Create a new song'.

Add two audio tracks (via Track > Add Tracks...) that we'll use as main track and side chain track.

Add audio files on both the main track and the side chain track. You can simply drag audio files from a
Finder/Explorer window onto a track.

Access the mix window via "Mix" in Studio One's bottom right corner.

Insert FabFilter Pro-C 3 on your main track via the '+' button next to the Insert tab.

Open FabFilter Pro-C 3's interface, enable Expert mode, and set Side Chain to Ext.
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On the side chain track, select Sends > Sidechains > FabFilter Pro-C 3.

Ableton Live

Open Ableton Live and start with an empty arrangement. We'll use Track 1 as the side chain track and Track 2 as
the main track.

From the folder menu's on at the left top of Ableton Live's interface, drag different audio clips to the first empty
slots of Track 1 and Track 2.

From the VST (or Audio Units) plug-in menu, also at the left top of Ableton Live's interface, drag FabFilter Pro-C
3 onto Track 2, the main track.

In the small device interface for Pro-C 3 in the bottom Effects section, choose 'Track 1' from the 'Sidechain' drop
down menu.

Open FabFilter Pro-C 3's interface, enable Expert mode, and set Side Chain to Ext.

Note: In earlier versions of Ableton Live (< 10.1), setting up sidechaining worked differently, which is described
here .

Logic Pro

Open Logic Pro and create a new empty project via File > New...

Add two audio tracks (via Track > New...) that we'll use as main track and side chain track.

Add audio files on both the main track and the side chain track. You can simply drag audio files from a
Finder/Explorer window onto a track.

Select the main track and add Pro-C 3 in the first Insert effect slot.

Open FabFilter Pro-C 3's interface, enable Expert mode, and set Side Chain to Ext.

In the right top corner of the plug-in interface header, in the 'Side Chain' menu, choose the side chain track.
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Now, the signal from the side chain track is sent to FabFilter Pro-C 3's external side-chain input.

Cubase

Open Cubase and create a new empty project.

Add two audio tracks that we'll use as main track and side chain track.

Add audio files on both the main track and the side chain track. You can simply drag audio files from a
Finder/Explorer window onto a track.

Open the Mixer. In the main track, click on an empty insert slot and select the VST 3 version of FabFilter Pro-C 3
in the Dynamics menu (note the VST 3 icon which looks like ///).

Open FabFilter Pro-C 3's interface, enable Expert mode, and set Side Chain to Ext.

In the plug-in header, click on the Activate Side-Chain button (right of the R/W buttons) to enable the external
side chain in Cubase.

At the top of the Mixer, set the output for the side chain track to the side-chain input of FabFilter Pro-C 3.

Next: License agreement
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FabFilter Software License Agreement
This license agreement concerns and describes your rights and the conditions upon which you may use the FabFilter
software you selected. We advise you to read this entire agreement. By accepting this agreement or by using FabFilter
software, you agree to all of these terms. If you do not accept and comply with these terms, you may not use the
FabFilter software or its features.

Applicability

This license agreement applies to all the FabFilter software, plug-ins and programs you may use during the Evaluation
period, and/or thereafter subject to an acquired license key to certain FabFilter software of any version, including any
and all upgrades, supplements or services, unless other terms come with such versions, upgrades or supplements.

Licenses

The FabFilter software will be licensed to the Customer, not sold. After full payment you will be granted a FabFilter
license key, which will give you the right to install, run and use the FabFilter software under the given conditions.
These conditions vary subject to the license you acquired. FabFilter distinguishes the following licenses to FabFilter
software ('the software'):

A Personal License is a named license to the software concerned granting the designated person who acquired
the FabFilter license key access to the software on three (3) devices. Usage of the Personal License by someone
else other than the designated licensee is an infringement of the rights of FabFilter. The Customer should at all
times protect its license key from theft and/or abuse.

A Site License is a non-personal license to the FabFilter software concerned, granting the designated institution
or other legal entity that acquired the FabFilter license key access to the software. A Site License will grant
access to the software on the maximum number of designated Devices, specified in the license key itself (e.g.
"20 seats"). If the Site License is used on computers/servers for any form of automated processing, the licensee
may not make any plug-in controls/parameters of the FabFilter software available to the end users of the
FabFilter software, i.e. only "black box" processing is allowed.

These FabFilter licenses, whether a Personal or Site License, will give you access to certain FabFilter software of the
specified major version. The license will include all future minor updates to the software (e.g. version 2.19 to version
2.20), which typically include bug fixes or small new features. The license will exclude any future new major versions
of the products (e.g. version 1.x to version 2.x). To allow yourself access to such new major version of the software, a
new FabFilter license to such major version must be acquired.

All FabFilter licenses, both Personal or Site License, give the Customer or end user the right to install and use the
FabFilter software to the extent it has been developed and under the conditions herein. Any rights not explicitly
granted to you, the Customer, remains with FabFilter, including but not limited to the right to alter, reverse engineer,
reverse compile, take apart, or disassemble the FabFilter software or any of the files in the distribution.

A Bundle License is Personal or Site License for multiple FabFilter software products, which gives the Customer or end
user the right to install and use the specific software products that the bundle (e.g. Total Bundle) contains at the
moment of purchasing the Bundle License. Any software products or new major software versions added to the bundle
after that date cannot be claimed as part of the prior acquired Bundle License. A Bundle License (if not Educational or
NFR) can only be transferred as a whole, using a License Transfer.

An Upgrade License is a Personal or Site License for a new major version of FabFilter software. You may only use an
Upgrade License if you have a license for the previous major version of the same FabFilter software.

Educational (EDU) and NFR licenses

A Personal or Site License can be marked as EDU (Educational) or NFR (Not For Resale), meaning the following:

A Personal or Site License marked as Educational License is equal to the respective Personal or Site License, with
the only exception that the Educational License may not be transferred to a third party.

A Personal or Site License marked as NFR ("Not For Resale"), is typically intended for journalists that wish to
review the FabFilter software. A License marked as NFR is equal to the respective Personal or Site License, with
the only exception that the NFR License may not be transferred to a third party.

Duration and Evaluation

As specified in the specific terms per license, all licenses will be granted in perpetuity (meaning that the license
agreement shall not automatically expire at any moment in time), however the license may be cancelled if not all
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conditions herein are respected.

To verify the correct use and compliance with our terms and conditions we have created the option for the FabFilter
software to contact our FabFilter web server periodically. With this verification we collect certain data (device ID,
device name and identifier of the license key) to check the validity of the use of the registered license on the identified
device. If such use appears not to be compliant with our terms, further access to the FabFilter Software will be denied.

The Evaluation period is a period of thirty (30) days commencing on the first day of using the software concerned and
automatically expiring 30 days thereafter. After the Evaluation period has expired and no FabFilter license key has
been acquired, the software will stop working and should be removed from your computer.

In addition to any and all such possibilities that FabFilter may have in accordance with the law, FabFilter may
terminate without prior notice or warning in case of abuse of the FabFilter software or fraud, as well as in case of your
(personal) bankruptcy.

Support

FabFilter shall give its reasonable commercial efforts to service any major version of any FabFilter software including
email support. FabFilter is entitled to terminate support for any major version of any FabFilter software at any time at
its sole discretion.

License Transfer

A Personal or Site License (not Educational or NFR License) may be transferred to a third party. In order to transfer
your license, you will have to buy a 'License Transfer' to activate the 'transfer'-option in your FabFilter account . After
this option has been activated you will be able to transfer your license to any third party. With this transfer of your
Personal or Site License, you will no longer be able to access the software.

Third Party Software

VST is a trademark of Steinberg Media Technologies GmbH. RTAS and AAX are trademarks of Avid Technology, inc.
Audio Units is a trademark of Apple Computer, inc.

Applicable Law

This license agreement is governed by Dutch law. The courts of Amsterdam are authorized courts to rule on any
dispute that may arise from this license agreement.

Disclaimer

TO THE MAXIMUM EXTENT PERMITTED BY LAW, FABFILTER B.V. SPECIFICALLY DISCLAIMS ALL WARRANTIES,
EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FABFILTER B.V. DOES NOT WARRANT THAT THE
SOFTWARE WILL MEET YOUR REQUIREMENTS OR THAT THE SOFTWARE WILL OPERATE ERROR-FREE OR
UNINTERRUPTED. TO THE MAXIMUM EXTENT PERMITTED BY LAW, FABFILTER B.V. SHALL NOT BE LIABLE FOR ANY
DAMAGE A FABFILTER PRODUCT MAY CAUSE OR DAMAGES THAT MAY ARISE OUT OF THE USE OF A FABFILTER
PRODUCT OR INABILITY TO USE A FABFILTER PRODUCT, INCLUDING BUT NOT LIMITED TO SPECIAL, INCIDENTAL,
CONSEQUENTIAL OR OTHER DAMAGES. IN NO EVENT FABFILTER B.V. WILL BE LIABLE FOR AN AMOUNT IN EXCESS
OF TWO HUNDRED FIFTY EUROS (€ 250,00).
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About FabFilter
Beautiful sound. Fantastic workflow. These are the foundations of FabFilter. We create powerful audio plug-ins with
superb sound quality and innovative interfaces.

A unique perspective

At FabFilter, we make the best possible tools for music production and audio processing. To achieve this, we
continually rethink and challenge industry standards: we've never been afraid of reinventing the wheel. Considering
every little detail, we tune our algorithms and interfaces until they sound perfect, look amazing and feel great to work
with.

It's the sound that counts

Above everything else, you need superb sound quality. That's why we put a lot of effort into developing unique audio
processing algorithms, ranging from our famous resonating filters to transparent high-end EQ and dynamics
processing.

Innovative interfaces, great design

Every FabFilter plug-in has an easy-to-use, well-designed interface aimed at providing unsurpassed workflow. Our
plug-ins focus on the task you're performing at that specific moment: they expose the features you need, when you
need them. And because of our special attention to design, you'll be delighted every time you open a FabFilter plug-in.

Don't take our word for it

We always set the highest standard for sound quality, usability and design to make truly great products that raise the
bar on what audio software can do. That's why we're very happy with the praise we've received from users and press
alike:

"In the decade since the release of its first plug-in, One, FabFilter has made an indelible mark on the music
production landscape." — Computer Music magazine

"While many other software developers are busy trying to model hardware, FabFilter is leaving them in the
dust by being visionaries and reaching into the future. FabFilter stuff is just on another level." — Jeff
Sanders

"FabFilter has an enviable reputation for making easy-to-use, powerful tools." — Music Tech magazine

FabFilter was founded in 2002 by Frederik Slijkerman and Floris Klinkert, and is based in Amsterdam, The
Netherlands.
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